APPENDIX A

$PSS in Less Than 30 Minutes

P

his appendix will teach yoij enough about SPSS to com-
plete the exercises in Statistics for People Who (Think

They) Hate Statistics. Learning SPSS is not rocket science —
just take your time, work as slowly as you need to, and ask a
fellow student or your instructor for help il necessary.

You are probably familiar with other Windows applications, and
you will find that many SPSS features operate exactly the same.
We assume you know about dragging, clicking, double-clicking,
and working with Windows. If you do not, you can refer to one o
the many popular trade computer books for help. SPSS works with
Microsoft Windows versions 08, XP, 2000, and Me. It will not
work with any earlier versions of Windows. The people at SPS5
have et to certify it with Vista so it's unofficial. But guess whal?
Use it—it works. SPSS 15 takes advantage of Windows's special
architectiire as well as other features, such as shortcuss, right-
cligking, and multitasking.

This appendix is an introduction to SPSS {Version 15.x) and
shows you just some of the things it can do. Almost all of the infor-
mation in this appendix also can be applied to eatlier versions ol
SPSS, from version 11 through the current version, 15.

Throughout the examples in this appendix, we will use the sam-

_ple data set shown in Appendix C named Sample Data. Youare % el-
come to enter that data manually or download it from the Sage Web
site at http://wwwsagepub.com/salkindstudy or the author’s Web site
at http://soe.ku.edu/faculty/Salkindfstatsijhs?)e/ .
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Like other Windows-based applications, SPSS is organized as a
group and is available on the Start menu. This group was created
when you first installed SPSS. To start SPSS, follow these steps:

1.
2.

Click Start, then point to Programs.

Click the SPSS icon. When you do this, you will see the SPSS5
opening screen as shown in Figure A.1. You should note that

some computets are set up differently, and your SPSS icon
might be located on the desktop. In thai case, to open SPS5,
just double-click on the icon.
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Figure A.1 The Opening SPSS5 Screen
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The SPSS Opening Window

[

As you can see in Figure A1, the opening window presens a
series of options that allows you to select from running the Spgg
tutorial, entering data, posing an established query, creating a ey,
query using the Database Wizard, or opening an existing source of
data (an existing file). Should you not want to see this screen each
time you open SPSS, then click on the Don't show this dialog in the
future box in the lower left corner of the window.

For our purposes, we will click the Type in data option and cli¢}
OK because it is likely to be the one you first select upon opening
and learning SPSS. Once you do this, the Data View window (als,,
called the Data Editor) you see in Figure A2 becomes active. This
is where you enter data you want to use with SPSS once those dara
have been defined. Although you cannot see it when SPSS firs,
opens, there is another open (but not active) window as well. This
is the Variable View, where variables are defined and the parameters
for those variables are set.
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Figure A.2 The Data View Window
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The Viewer displays statistical results and charts that you create.
An example of the Viewer window is shown in Figure A.3. A data
set is created using the Data Editor, and once the set is analyzed or
graphed, you examine the results of the analysis in the Viewer.

If you think the Data Editor is similar to a spreadsheet in form
and function, you are right. In form, it certainly is, because the
Data Editor consists of rows and columns just like in Excel and
Lotus 1-2-3. Values can be entered and then manipulated. In func-
tion as well, the Data Editor is much like a spreadsheet. Values that
are entered can be transformed, sorted, rearranged, and more.
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Figure A.3  The Viewer

'HE SP5S TOOLBAR AND STATUS BAR

The use of the Toolbar, the set of icons that is underneath the
menus, can greatly facilitate your SPSS activities. If you want to
know what an icon on the Toolbar does, just place the mouse
pointer on it, and you will see a tip telling you what the tool does.
Some of the buttons on the Toolbar are dimmed, meaning they are
not active.

The Status Bar, located at the bottom of the SPSS window, is
another useful Bn-screen tool. Here, you can see a one-line report
regarding in which activity SPSS is currently involved. The message
SPSS for Windows processor is ready tells you that SPSS is ready
for your directions or input of data. Or, Running Means . . . tells
you that SPSS is in the middle of the procedure named Means.
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USING SP55 HELP

1f you need help, you have come to the right place. SPSS offers help
that is only a few mouse clicks away, and it is especially nsefy)
when you are in the middle of a data file and need informarigy
about an SPSS feature. SPSS Help is so comprehensive that even i
you are a niew SPSS user, it can show you the way.

You can get help in SPSS by pressing the F1 function key (se.
Figure A.2) or using the Help menu you see in Figure A4,
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Command Syntax Referance
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Check For Updates

Registar Product

Figure A4  The Various Help Options

Therg are 10 options on the Help menu, greatly expanded from
earlier versions of SPSS, and 6 are directly relevant to helping you.

Y
]

Topics gives you a list of topics for which you can get help.
Tutorial offers you a short tutorial on all aspects of using SPSS.
Case Studies gives you real live examples of how SPSS can be
applied.

Statistics Coach walks you through procedures step by step.
Command Syntax Reference helps you to learn and use SP55%
programming language.

SPSS Home Page takes you to the home page for SPSS on the
Internet. ‘
About . . . gives you some technical information about SPS5,
including the current version on which you are working.
License Authorization Wizard provides you with the tool to
authorize a license.

Register Product allows you to register your SPSS product(s).

e Check for Updates automatically connects to the SPSS mother
~ ship to check if there are any updates you should be aware of.
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t/sing the F1 Function Key

Any time you need help on any feature of SPSS, there is a quick
and easy way to get it. Press the F1 function key while you are
working, and you will see the Help dialog box shown in Figure A.5.
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i1 Help is provided in many different forms:

Help menu. The Help menu in most SPSS windows provides access, to the main Help

@ Distrinuted Analysis system, plus tutarials and technical reference material.
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Topics. Provides access to the Centents, Indek, and Search tahs, which you can use
ta find specific Help topics.

Tutorial. Ilustrated, step-by-step instructiorns oh how to use many of the basic
features in SPSS. You don't have to view the whole tutorial from start to finish, You
can choose the topics you want to view, skip around and view topics in any order,
and use the index or table of contants to find specific topics. You can also click hera
ta start the tutorial.

® @ Amalyzing Data

@ @ Buiding Charts + Case Studies. Hands-oh examples of how to create various typee of statistical

3§ Editing Cheris analyses and how ta interprst the results. The sampls data files used in the examples

i 4 Utiites are also provided so that you can work through the examples to see exactly how the

% & Options G results were produced, You can choose the specific procedure(s) that you want to

e &Cusmmizing Menus oo learn about from the table of contents or search for relevant topics in the irdex. You
@ Froduction Faciity \ can also glick hers to apen the Case Studies,
@ SPES Soripting Faclt £ ) ’ . )
& Cuput Menagement 11 + Stafistics Goach. & wizard-like approach to guide you through the process of finding

;82 Using Quipud as InpL the procedura that you want to use. After you make a serias of selections, the

i € Transtaring OXHL Statisties Ceach opens the dialog bos for the statistical, reporting, or charting

& %quwmw Asked Qu : " procadurs that meets your selected criteria. The Statistics Coach provides access to
@ Exnct Tests most statistical and reporting procedures In the Base system and many charting

= @ Publish tn e ! procaduras, You can also click hare to open the Statistics Coach,

, @ Database Accees 4,

2 Customizing HTML D ! » Command Syntax Reference. Detailed command syntax reference information is

& @ Accessiuiity : available in twe forms: integrated into the overall Help system and as a separate

& @ Command Syntax 4 1 document in POF form in the 288 Cormmand Syntax Reference, available from the Help

o } [ menu. Click here ta gpen the 8955 Command Syntax Reference. F
igure A.5  SPSS Help S

T_he Contents Tab

The Contents Tab describes the major headings for help.
Double-clicking on any one heading provides a list of possible top-
ics that you might want to consult for the help you need. The Index
tab in SPSS Help provides an alphabetical listing of help topics. The
Search Tab allows you to enter any words that may be part of a help
screen. SPSS thén searches for the word, rather than just present-
ing help on a topic. In effect, you are searching all the words in all
the topics. Finally, Favorites on the help menu lets you segregate
those topics you think you might have to go back to for more help.

‘It’s a way of saving your favorite help topics so you can quickly locate
them again.
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& DRIEF TOUR OF SP3S

Now, sit back and enjoy a brief tour of what SPSS can do. Nothin

fancy here. Just some simple descriptions of data, a test of signif

cance, and a graph. or two. What we are trying to show you is h.,

easy it is to use SPSS.

Opening a File

You can enter your own data to create a nelw' SPSS data file, use ay
existing file, or even import data from such applications as Microso[;
Excel into SPSS. Any way you do it, you need to have data to work
with. In Figure A.6, the data contained in Appendix C are shown
called Sample Data, and they are also available on the Internet site. |
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Figure A.6  An Open SPSS File
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imple Table and Graph

Fle Edt \ew Oota Trasform

aBn T

Now it is time to get to the reason why we are using SPSS in the
first place—the various analytical tools that are available.

First, let’s say we want to know the general distribution of males
and females. That is all, just a count of how many males and how
many females are in the total sample we are working with. We also
want to create a simple bar graph of the distribution.

In Figure A.7, you will see the output that provides exactly the
information we asked for, which was the frequency of the number
of males and females. We used the Frequencies option on the
Descriptive Statistics (under the main menu Analyze) to compute
these values. Then, we used the Graphs option to create a simple
bar graph of the frequency, as you can also see in Figure A.7.
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“Let's see if males and females differ in their average test] scores.
This is a simple analysis requiring a ¢ test for independent samples.
The procedure is a comparison between males and females for the
mean of testl for each group.
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In Figure A.8, you can see & partial summary of the results of the
t test, Notice that the listing in the left pane (the outline view) of
the SPSS Viewer now shows the Frequencies, Graph, and ¢ test pro-
cedures listed. To see any part of the output, all we need do is click
on that element. Almost always, when SPSS produces output in the
Viewer, you will have to scroll to see the entire output.
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Figure A.8  The Results of an Independent Samples t Test

Ry

CREATING AND EDITING A DATA FILE

As a hands-on exercise, lets create the beginning of the sample data
file you see in Appendix C. The first step is to define the variables
in your data set and then to enter the data. You should have a new
Data Editor window open (Click File — New — Data).

Defining Variables

SPSS cannot work unless variables are defined. You can have
SPSS define the variables for you, or you can do the defining
yourself, thereby having much more control over the way things
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look and work. SPSS will automatically name the first variable
VARO0001. If you defined a variable in row 1, column 5, then SPSS
would name the variable VAR00005 and also number the other

columns sequentially. But you can also define variables, assigning
a name of your choice.

ustom Defining Variables:
ing the Variable View Window

In order to define a variable, you must first go to the Variable
View window by clicking the Variable View tab at the bottom of the
SPSS screen. Once that is done, you will see the Variable View win-
dow, as shown in Figure A.9, and be able to define any one variable
as you see fit.

plame § ] s | Decimals [ Lahel F Values Missing " | -Columns Align Waasure

gure A.9 The Variable View Window

]
K}

Once in the Variable View window, you can define variables
along the followingiparameters:

Name provides a name for a variable up to eight characters.

Type defines the type of variable, such as text, numeric, string,
scientific notation, and so on.

Widrth defines the number of characters wide that the column
housing the variable will occupy.

Decimals. defines the number of decimals that will appear in the
Data View. 2

Label defines a label up to 256 characters for the variable.

Values defines. the labels that correspond to certain numerical
values (such as 1 for male and 2 for female).

Missing indicates how missing data will be dealt with.
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Columns defines the number of spaces allocated for the variah|e
in the Data View window:

Align defines how the data are to appear in the cell (righy lef,
or center aligned).

Measure defines the scale of measurement that best characterizeg
the vartable (nommal ordinal, or interval).

if vou place the cursor in the first cell under the Name colump,
enter any name, and press the Enter key, then SPSS will automan-
cally provide you with the default values for all the variable chy;
acteristics. Even if you are not in the Data View screen (click the
tab on the bottom of the window), SPSS will automatlcaliy Name
the variables var0001, var0002, and so on.

In the Variable View, enter the names of the variables as you see
in Figure A.10.
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Figure A.10  Defining Variables in the Variable View Window
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Now, if you wanted, you could switch to the Data View (see
Figure A.11)%and just enter the data as you see in Figure A.6. But
first, let’s look at just one of the cool SPSS bells and whistles.
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Figure A.11 The Data View Window Ready to Have Data Entered With the
Defined Variables
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ning Variable Labels

You can leave your data appearing as numerical values in the
SPSS Data Editor, or you can have labels represent the numerical
values (as you saw in Figure A.6}.

Why would yon want to change the label of a variable? You
probably already know that,.in general, it makes more sense to
work with numbers (like 1 6r-2) than with string or alphanumeric
variables {such as male or female).

But it sure is a lot easier to look at a data file and see words %
rather than numbers. Just think about the difference between data : ]
files with numbers representing various levels (suchas 1 and 2) of :
a variable and with the actual values {(such as male and female).
The Values option in the Variable View screen allows you to enter
values in the cell, but what you will see are value labels.

If you click the ellipsis button in the Values column (see
Figure A.12), you will see the Value dialog box, as shown in
Figure A.13.
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Changing Variable Labels

To assign or change a variable label, follow these steps. Here, e
will label males as 1 and females as 2.

1. For the variable gender, click on the ellipsis (see Figure A.12)
to open the Value Labels dialog box.

2. Enter a value for the variable, which, in this case, will be 1 fo;
males.

3. Enter the value label for the value, which is male.

4. Click Add.

5. Do the same for female and value 2. When you finish your
business in the Define Labels dialog box (see Figure A.14)
click OK, and the new labels will take effect.

iﬁaluPLai:}P! : e _ : e el

n
: o 1 _
':L_abel: % ‘ - l Cancs
L - Hel
: sokt b 100 ="Male" ._EJ

200 = "Female"

Figure A.14 The Completed Value Labels Dialog Box

When $ou select View — Variable Labels from the main menu,
you will see the labels in the Data Editor as you do in Figure A.15.
Notice how the value of the entry in Figure A.15 is actually 2, even
though the label in the cell reads Female.
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File Edit Wiew Data Transform Analyze Graphs
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5 5.00, Male Experiment| 7600,  B4.00

gure A.15  Seeing Variable Labels

Opening a Data File

Once a file is saved, you have to open or refrieve it when you
want to use it again. The steps are simple.

L." Click File — Open. You will see the Open Data File dialog box.

[

. Find the data file you want to open, and highlight it.
3. Click OK.

e

A quick Wayito find and Open an SPSS file is by clicking on its
name at the bottom of the File menu. SPSS lists the most recently
used files there.

PRINTING WITH SP55

Here comes information on the last thing you will de once a data
file is created. Once you have created the data file you want or
completed any* type of analysis or chart, you probably will want to
print out a hard copy for safekeeping or for inclusion in a repori or
paper. Then, when your SPSS document is printed and you want to
stop working, it is time to exit SPSS.




316 Statistics for People Who (Think They) Hate Statistie
s

Printing is almost as important a process as editing and sayi,
data files. If you cannot print, you have nothing to take away from
your work session. You can export data from an SPSS file to anggh,,
application, but getting a hard copy directly from SPSS is e,
more timely and more important.

Printing an SPSS Datd File

It is simple to print either an entire data file or a selection from oy

1. Be sure that the data file you want tosprint is the active window

2. Click File — Print. When you do this, you will see the Prin
dialog hox. .

3. Click OK, and whatever is active will print..
As you can see, you can choose to print the entire document or
a specific selection (which you will have already made in the Data

Editor window), and to increase the number of copies from 1 to 99
(the max number of copies you can print).

Printing a Selection From an SPSS Data File

Printing a selection from a data file follows exactly the steps thai
we listed above for printing a data file, except that in the Data
Editor window, you select what you want to print and click on the
Selectipn option in the Print dialog box. The steps go like this:

1. Be sure that the data you want to print are selected.
2. Click File — Print.

3. Click Selection in the Print dialog box.

4

. Click OK, and whatever you selected will be printed.

CREATING AN 5PSS CHART

A picture is worth a thousand words, and SPSS offers you just the
features to create charts that bring the results of your analyses t©
life. In this part of Appendix A, we will go through the steps 10
create several different types of charts and provide examples of

, ﬂ
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different charts. Then, we will show you how to modify a chart,
including adding a chart title; adding labels to axes; modifying
scales; and working with patterns, fonts, and more. For whatever
reason, SPSS uses the words “graphs” and “charts” interchangeably.

Creating a Simple Chart

The one thing that all charts have in common is that they are
based on data. Although you may import data to create a chart, in
this example, we will use the data from Appendix C to create a bar
chart (like the one you saw in Figure A.7) of the riumber of males
and females in each group.

Creating a Bar Chart

The steps for creating any chart are basically the same. You first
enter the data you want to use in the chart, select the type of chart
you want from the Graphs menu, define how the chart should
appear, and then click OK. Here are the steps we followed to create
the chart you see in Figure A.7.

1. Enter the data you want to use to create the chart.

2. Click Graphs — Legacy Dialogs — Bar. When you do this,
you will see the Bar Charts dialog box you see in Figure A.16.

Simple . £

Cancel
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Stac:.kex:l _

Drata irs Chart Are

LT . e

2 (f Suramaries for groups of cases

{3 Summaries of separate vanables
T alues of individual ases

Figure A.16 The Bar Charts Dialog Box
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3. Click Simple.
4. Click Summaries for groups of cases.

5 Click Define. When you do this, you will see the Define
Simple Bar: Summaries for Groups of Cases dialog box.

6. Click Cum n of cases.

7. Click gender, then click » to move the variable to the
Category Axis area.

8. Click OK, and you see the results of the chart in Figure A17.

Graph

100+

25

g —
hiale Femals

Gender

%

Figure A.17 A Simple Bar Chart

Thats just the beginning of the chart, and to make any changes,

you have to use the chart editor tools. Let’s learn how to save the

chart and then move to making changes.

Saving a Chart

A chart is only one component of the Viewer window. A chart1s
part of the output generated when you perform some type of
analysis. The chart is not a separate entity that stands by itself, and
it canmot be saved as such. To save a chart, you need to save the
contents of the entire Viewer. Follow these steps to do that
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1. Click File — Save.
9. Provide a name for the Viewer window.

3. Click OK. The output is saved under the name that you pro-
vide with a .spo extension.

Omce you create a chart as we showed you in the previous section,
you could finish the job by editing the chart to reflect exactly what
you want to say. Colors, shapes, scales, fonts, and more can be
changed. We will be working with the bar chart that was first shown
to you in Figure A.7.

The first step in editing a chart is to double-click on the chart,
then click the maximize button. You will see the entire chart in
Figure A.18 in the Chart Editor window.

T
Female

Hi37S, Wie68.75 puints

Figuré A.18 The Chart Editor Window
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L
Working With Titles and Subtitles

Our first task is to enter a title and subtitle on the chart you sz
in Figure A.17.

1. Click the Insert a Title icon (which looks like this [icon here]
on the Toolbar. When you do this, as you see in Figure A 19,
you can then edit the element Tidle right on the screen ané
enter what you wish.
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Figure A.19 Inserting a Title

2 To insert a subtitle (or, in fact, as many titles as you like), just

keep clicking the Insert a Title toolbar.
Wor

Working With Fonts §

Once you have created a title or titles, you can work with fonts
by double-clicking on the text you want to modify, and you will see
the Properties dialog box as shown in Figure A.20. Click on the Text
Style tab as we have and you can make whatever changes you wish.
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Figure A.20  Working With Fonts

Working With Axes

~ The x and y-axes provide the calibration for the independent
(usually the x-axis) variable and the dependent (usually the y-axis)
variable. SPSS names the y-axis the Scale axis and the x-axis the
Category axis. Each of these axes can be modified in a variety of
ways. To modify either axis, double-click on the title of the axis.
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How to Modify the Scale (y) Axis
To modify the y-axis, follow these steps:

1.

‘Select the options you want from the Scale Axis dialog hox.

Still in the chart editor? We hope so. Double-click op thex
label of the axis.

Click the Scale tab in the Properties dialog box. When you g,
this, you will see the Scale AXls dialog box, as shown ip
Figure A.21. )
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Figure A.21 The Scale Axis Dialog Box
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jow to Modify the Category (x) Axis

Working with the x-axis is no more difficult than working with
the y-axis. Here is how the x-axis was modified.

1. Double-click on the label of the x-axis. The Category Axis
dialog box opens. It is very similar to the Scale Axis dialog
box that you saw in Figure A.21.

2. Select the options you want from the Category Axis dialog
box.

We made some text changes in the final graph such as:
Changed Cumulative Frequency to Number |

Changed gender to Gender

When you are done making changes (and the chart looks some-
thing like that shown in Figure A.21), close the Chart Editor by
double-clicking on the window icon or selecting File — Close.

DESCRIDING DATA

Now you have some idea about how data {iles are created in SPSS.
Let’s move on to some examples of simple analysis.

&

Frequencies and Crosstab Tables |

Frequencies simply compute the number of times that a partic-
ular value occurs. Crosstabs allows you to compute the number
of times that a value occurs when categorized by one or more
dimensions, such as gender and age. Both frequencies and crosstabs
are often reported first in research reports because they give the
reader an overview of what the data look like. To compute fre-
quencies, follow these steps. You should be in the Data Editor

~window. =

L. Click Analyze — Descriptive Statistics — Frequencies. When |

you do this, you will see the Frequencies dialog box as shown
‘in Figure A.22.
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Figure A.22  The F'requencies Dialog Box

2. Double-click the variables for which you want frequencies
computed. In this case; they are testl and test2.

3. Click Statistics. You will see the Frequencies: Statistics dialog
box, as shown in Figure A.23.
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Figure A.23 The Frequencies: Statistics Dialog Box

4. In the Dispersion area, click Std. deviation.

5. Under the Central Tendency area, click Mean.
6. Click Continue.

7. Click OK.

The output consists of a listing of the frequency of each value for
testl and test2, plus summary statistics {mean and standard deviation)
for each, as you see in Figure A.24.
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Frequencies

Statistics
test1 fest2
N Valid 25 25
Missing ] 0
Mean ) 83.5200 64.2400
Std. Deviation n 8.82709 21.64155

Figure A.24 Summary Statistics for testl and test2

pplying the Independent Samples t Test

females in reading.

How to Conduct an Independent Samples t Test

To conduct an independent ¢ test, follow these steps.

Samples T Test dialog box, as shown in Figure A.25.
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Independent ¢ tests are used to analyze data from a number of
types of studies, including experimental, quasi-experimental, and
field studies such as those shown in the following example, where
we test the hypothesis that there are differences between males and

1. Click Analyze — Compare Means — Independent-Samples
T Test. When you do this, you will see the Independent-

Figure A.25 -The Independent Samples 7 Test Frequencies Dialog Box
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The Independent Samples t Test Dialog Box

On the left-hand side of the dialog box, you see a listing of alj
the variables that can be used in the analysis. What you now need
to do is define the test and the grouping variable.

5. Click testl, then click » in the Test Variables box to move it

to the Test Variables area.

3. Click gender, ‘then click » to move it to the Grouping

Variable area.

. Click Define Groups.

. In the Group 1 box, type 1.

Click
. Click

The ouiput

Continue.

OK.

4
5
6. In the Group 2 box, type 2.
7
8

contains the means and standard deviations for each
variable, plus the results of the r test, as shown in Figure A.26.

T-Test
Group Statistics
Group N Mean Std. Deviatjon Std. Error MeaﬂW
testl Experimental 8 85.7500 7.81482 2.76296
Control 17 82.4706 2.01469 2.18638
¢
, Independent Samples Test
( levene's B 4\
Test for
Eguality of
Variances ttest for Equality of Means
95% Confidence
Interval of the
Sig. Mean Std. Error Differance
F | Sig.| 't df (2-tailed) | Difference Difference Upper
test1 Equal 679 .418; .883 23 3871 3.2794 3.71600 | -4.40771 | 10.96654
variances +
assumed
Equal .931115.801 368 |  3.27941 252338 | —4.19748 |10.75630
variances
not assumed

Figure A.26 Results of the Simple t Test
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We have just given you the briefest of intreductions to SPSS, and
certainly none of these skills means anything if you don’t know the
value or meaningfulness of the data you originally entered. So,
don’t be impressed by your or others’ skills at using programs like
SPSS. Be impressed when those other people can tell you what the
output means and how it reflects on your original question. And be
really impressed if you can do-it!

EXITING SP55S

To exit SPSS, click File — Exit. SPSS will be sure that you get the
chance to save any unsaved or edited windows and will then close.
Ta-da! You're done!
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